MANUAL

WHA-ADP2-F8B2-**-Z1(-EX1)

WirelessHART® Adapter
With regard to the supply of products, the current issue of the following document is applicable: The General Terms of Delivery for Products and Services of the Electrical Industry, published by the Central Association of the Electrical Industry (Zentralverband Elektrotechnik und Elektroindustrie (ZVEI) e.V.) in its most recent version as well as the supplementary clause: "Expanded reservation of proprietorship"
1 Safety .................................................................................................................. 6
  1.1 Validity........................................................................................................... 6
  1.2 Symbols Used ............................................................................................... 6
  1.3 Target Group, Personnel ............................................................................. 6
  1.4 Reference to Further Documentation .................................................... 7
  1.5 Marking ......................................................................................................... 7
  1.6 Intended Use ................................................................................................. 7
  1.7 Improper Use ............................................................................................... 7
  1.8 Mounting and Installation .......................................................................... 8
  1.9 Housing ........................................................................................................ 8
  1.10 Operation, Maintenance, Repair ......................................................... 9
  1.11 Delivery, Transport, Disposal ............................................................... 9

2 Product Specifications ....................................................................................... 10
  2.1 Introduction ................................................................................................. 10
  2.2 Functional Overview ................................................................................. 11
  2.3 Scope of Delivery ....................................................................................... 11
  2.4 Design ........................................................................................................ 12

3 Installation .......................................................................................................... 14
  3.1 Mounting Considerations .......................................................................... 14
    3.1.1 Positioning the Device ......................................................................... 14
    3.1.2 Antenna Characteristics ...................................................................... 15
    3.1.3 Examples for Good and Poor Positioning ........................................ 16
  3.2 Mounting the Device ............................................................................... 17
    3.2.1 Installation on a Field Device ........................................................... 18
    3.2.2 Mounting to a Wall ............................................................................ 19
    3.2.3 Mounting to a Pipe .......................................................................... 20
  3.3 Electrical Connection to other Devices ............................................... 21
    3.3.1 Wiring Diagrams .............................................................................. 22
    3.3.2 Connecting Cables ............................................................................ 25
4 Commissioning

4.1 Connected HART Device(s)
4.2 Connecting the Battery
4.3 Initial Configuration via HART Modem
4.4 DTM Software
  4.4.1 Downloading the Required Software
  4.4.2 Installing the DTM Software Components
  4.4.3 Updating the DTM Catalog
4.5 Creating a new Project in PACTwareTM
  4.5.1 Creating a New Project
  4.5.2 Adding the Communication DTM
  4.5.3 Adding Device DTM
4.6 Joining the Wireless Network

5 Configuration

5.1 Configuration Options
5.2 Online and Offline Parameterization (PACTware)
5.3 Identification Parameters
5.4 Wireless Communication Parameters
5.5 Wired Communication Parameters
5.6 Device Variable Mapping
5.7 Application Settings
  5.7.1 4...20 mA
  5.7.2 Burst Mode Parameters
  5.7.3 Event Notification
5.8 Power Supply

6 Operation

6.1 Controls and Indicators
  6.1.1 LEDs
  6.1.2 Buttons
6.2 Measured Value
### 6.3 Simulation

### 6.4 Diagnostics
- **6.4.1** Identification .................................................. 64
- **6.4.2** Wireless Communication .......................................... 65
- **6.4.3** Wired Communication ................................................ 66
- **6.4.4** Health Status.............................................................. 66
- **6.4.5** Power Supply ............................................................ 69

### 6.5 Additional Functions
- **6.5.1** Lock / Unlock ........................................................... 70
- **6.5.2** Update Firmware ...................................................... 70
- **6.5.3** Device DTM Info ......................................................... 71
- **6.5.4** Self Test ......................................................................... 71
- **6.5.5** About ............................................................................. 72

### 7 Maintenance and Repair

#### 7.1 Exchanging the Battery .................................................. 73
#### 7.2 Disposal of Batteries ......................................................... 74

### 8 Troubleshooting
- **8.1** Faults Indicated by LEDs............................................... 75
- **8.2** Wireless Communication Faults ....................................... 76
- **8.3** Wired Communication Faults .......................................... 77

### 9 Appendix
- **9.1** Telecommunication Compliance ................................... 79
- **9.2** Dimensions ............................................................... 80
1 Safety

1.1 Validity
The chapter “Safety” is valid as instruction manual.
Specific processes and instructions in this instruction manual require special provisions to
guarantee the safety of the operating personnel.

1.2 Symbols Used
This document contains symbols for the identification of warning messages and of informative
messages.

Warning Messages
You will find warning messages, whenever dangers may arise from your actions. It is mandatory
that you observe these warning messages for your personal safety and in order to avoid
property damage.
Depending on the risk level, the warning messages are displayed in descending order as
follows:

Danger!
This symbol indicates an imminent danger.
Non-observance will result in personal injury or death.

Warning!
This symbol indicates a possible fault or danger.
Non-observance may cause personal injury or serious property damage.

Caution!
This symbol indicates a possible fault.
Non-observance could interrupt the device and any connected systems and plants, or result in
their complete failure.

Informative Symbols
Note!
This symbol brings important information to your attention.

Action
This symbol indicates a paragraph with instructions. You are prompted to perform an action or
a sequence of actions.

1.3 Target Group, Personnel
Responsibility for planning, assembly, commissioning, operation, maintenance, and
dismounting lies with the plant operator.
The personnel must be appropriately trained and qualified in order to carry out mounting,
installation, commissioning, operation, maintenance, and dismounting of the device. The
trained and qualified personnel must have read and understood the instruction manual.
1.4 Reference to Further Documentation

Observe laws, standards, and directives applicable to the intended use and the operating location. Observe Directive 1999/92/EC in relation to hazardous areas.

The corresponding datasheets, manuals, declarations of conformity, EU-type examination certificates, certificates, and control drawings if applicable (see datasheet) are an integral part of this document. You can find this information under www.pepperl-fuchs.com.

Due to constant revisions, documentation is subject to permanent change. Please refer only to the most up-to-date version, which can be found under www.pepperl-fuchs.com.

1.5 Marking

WirelessHART®-Adapter
WHA-ADP2-F8B2-0-P0-Z1-EX1
Pepperl+Fuchs GmbH
Lilenthalstraße 200, 68307 Mannheim, Germany
EC-Type Examination Certificate: BVS 17 ATEX E 029, for additional certificates see www.pepperl-fuchs.com
II 2 G Ex ia IIC T4/T3 Gb

WirelessHART®-Adapter
WHA-ADP2-F8B2-0-A0-Z1-EX1
Pepperl+Fuchs GmbH
Lilenthalstraße 200, 68307 Mannheim, Germany
EC-Type Examination Certificate: BVS 17 ATEX E 029, for additional certificates see www.pepperl-fuchs.com
II 2 G Ex ia IIC T4/T3 Gb
II 2 D Ex tb [ia] IIIIC T70°C Db

1.6 Intended Use

The device is only approved for appropriate and intended use. Ignoring these instructions will void any warranty and absolve the manufacturer from any liability.

The device must only be operated in the specified ambient temperature range and at the specified relative humidity without condensation.

The device is used in control and instrumentation technology (C&I technology) for wireless data transfer from HART devices.

Take the intended use of the connected devices from the corresponding documentation.

1.7 Improper Use

Protection of the personnel and the plant is not ensured if the device is not used according to its intended use.
1.8 Mounting and Installation

Prior to mounting, installation, and commissioning of the device you should make yourself familiar with the device and carefully read the instruction manual.

Do not mount the device at locations where an aggressive atmosphere may be present.

Do not mount a damaged or polluted device.

Only use accessories specified by the manufacturer.

Avoid electrostatic charges which could result in electrostatic discharges while installing, operating, or maintaining the device.

If the device has already been operated in general electrical installations, the device may subsequently no longer be installed in electrical installations used in combination with hazardous areas.

Observe the installation instructions according to IEC/EN 60079-14.

Connection or disconnection of energized non-intrinsically safe circuits is only permitted in the absence of a potentially explosive atmosphere.

If circuits with type of protection Ex i are operated with non-intrinsically safe circuits, they must no longer be used as circuits with type of protection Ex i.

The usage of 2400 MHz equipment is bound to local restrictions. Ensure that local restrictions allow usage of this device before commissioning.

<table>
<thead>
<tr>
<th>Country</th>
<th>Guideline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bulgaria</td>
<td>General authorization required for outdoor use and public service.</td>
</tr>
<tr>
<td>Italy</td>
<td>If used outside of own premises, general authorization is required.</td>
</tr>
<tr>
<td>Japan</td>
<td>The device is granted pursuant to the Japanese Radio Law and the Japanese Telecommunications Business Law. The device must not be modified (otherwise the granted designation number will become invalid).</td>
</tr>
<tr>
<td>Latvia</td>
<td>The outdoor usage of the 2.4 GHz band requires an authorization from the Electronic Communications Office.</td>
</tr>
<tr>
<td>Norway</td>
<td>May be restricted in the geographical area within a radius of 20 km from the center of Ny-Alesund.</td>
</tr>
<tr>
<td>Rumania</td>
<td>Use on a secondary basis. Individual license required.</td>
</tr>
</tbody>
</table>

1.9 Housing

Ensure that the housing is not damaged, distorted, or corroded.

Ensure that all seals are clean, undamaged, and correctly fitted.

Tighten all screws of the housing/housing cover with the appropriate torque.

For cable glands only use incoming cable diameters of the appropriate size.

Tighten all cable glands with the appropriate torque.

Close all unused cable glands with the appropriate sealing plugs.

Close all unused enclosure holes with the appropriate stopping plugs.

1.10 Operation, Maintenance, Repair

Do not repair, modify, or manipulate the device.

If there is a defect, always replace the device with an original device.

When the device is in operation, maintain at all times a distance of at least 20 cm to the device antenna. This also applies to any other person in the vicinity of the device.
The housing may be opened for maintenance while energized in Zone 1.

Only use accessories specified by the manufacturer.

Observe the separate safety instructions of the battery manufacturer before storing, handling, transporting and disposing of the batteries.

Leaking battery acid may cause personal injury and damage to the device.

- Never use batteries that are leaking.
- Never use batteries with external damages, even if no battery acid is leaking.
- Check the battery compartment for leaking battery acid at regular time intervals.

Remove the dust before opening the housing.

1.11 Delivery, Transport, Disposal

Check the packaging and contents for damage.

Check if you have received every item and if the items received are the ones you ordered.

Keep the original packaging. Always store and transport the device in the original packaging.

Store the device in a clean and dry environment. The permitted ambient conditions must be considered, see datasheet.

Disposing of device, packaging, and possibly contained batteries must be in compliance with the applicable laws and guidelines of the respective country.
2 Product

2.1 Introduction

The HART® (Highway Addressable Remote Transducer) communication protocol is used by many 4 ... 20 mA transmitters to enable digital communication for diagnosis and maintenance purposes. Many device parameters, but also measurement values, can be transmitted digitally to and from the device. Until now, HART® technology has mostly been using the wired 4 ... 20 mA loop as physical layer.

WirelessHART® technology now allows for the wireless transmission of HART® data. To be employable worldwide, WirelessHART® technology utilizes the 2.4 GHz Band (IEEE 802.15.4 wireless network) as physical layer. All WirelessHART devices form a mesh network in which every device is not just a measurement point, but also a repeater. This results in a bigger range of the whole network as well as an increased reliability through redundant communication paths.

![WirelessHART mesh network](image)

Figure 2.1 WirelessHART mesh network

1. WirelessHART Temperature Converter
2. WirelessHART Adapter
3. WirelessHART Gateway
4. Fieldbus/Ethernet
5. Host applications

The WirelessHART network is built up, organized and maintained by the WirelessHART Gateway and is therefore self-organizing and self-healing. The WirelessHART Gateway also takes care for connection to different host systems through different industrial protocol bus interfaces.

The WirelessHART Gateway supplies WirelessHART Temperature Converters and WirelessHART Adapters with the necessary information for seamless network operation.
2.2 Functional Overview

The WirelessHART adapter is an intelligent interface module that connects HART and 4 ... 20 mA devices to a WirelessHART network. It transmits the measurement and diagnosis information acquired from the connected device(s) to a host application via the WirelessHART Gateway.

**Key Functions**
- May be connected directly to a HART device or mounted separately. Up to 4 HART devices may be connected.
- LEDs for supply status, communication status and device status indication.
- Provides loop-power to the connected device. Alternatively, the connected device may be powered externally.
- Battery life estimation and "Low Battery" alarm

2.3 Scope of Delivery

The scope of delivery of the WirelessHART adapter includes:
- WirelessHART Adapter with installed battery unit W-BAT-B2-Li, if ordered
- Short instructions and CD-ROM

Depending on the order, the delivery may also include the following:
- Wall/pipe mounting kit
- 38 cm cable for connecting the adapter to a field device
- A connection adapter for connecting to the cable entry of a field device: M20/M20 or M20/G 1/2 with two Viton gaskets, M20/NPT 1/2 or M20/NPT 3/4 with one Viton gasket.
- Cable gland
2.4 Design

Controls and Indicators

The button and the LED indicators are inside the housing.

Further information on the indications of the LEDs and the functions of the button: see chapter 6.1.

Figure 2.2 Controls and indicators

1 Red LED
2 Green LED
3 Yellow LED
4 Button
Connections and Interfaces

Figure 2.3 Connections and interfaces

1  Housing cover with battery compartment
2  Connector for battery power
3  Antenna
4  Counternut
5  Primary M20x1.5 cable gland
6  Secondary M20x1.5 cable gland
7  Terminal block
3 Installation

3.1 Mounting Considerations

3.1.1 Positioning the Device

We recommend that you install the WirelessHART gateway before installing other WirelessHART devices. This way, you can check for proper operation of new devices as they are installed. Please refer to the manual of the WirelessHART gateway for further information.

Guidelines for Planning a WirelessHART Network

- A line-of-sight between communication partners always is desirable. If a line-of-sight is not possible, the obstacles should not be massive and the partners should be more to the edge of an obstacle to allow the wave to “bend” around it (diffraction effect).
- Consider moving objects that could affect the device’s antenna range.
- Install wireless devices at least 1 m above the ground.
- Make sure that the device’s antenna is aligned vertically for best results.
- Make sure that a minimum of 2 other WirelessHART devices are well within the antenna range of the device.
- Do not position WirelessHART devices directly below or above each other. They would be outside each other’s antenna range.
- Install WirelessHART devices at least 1 m away from each other.
- Antennas must be at least 6 cm away from any wall or any metallic material running parallel to it.
- Position the device as far away as possible from metal surfaces or walls containing metal. There should be as little metal close to the device as possible.
- Do not position other 2.4 GHz devices like cordless phone bases or WLAN routers near WirelessHART devices. Keep in mind other wireless networks using the same frequency spectrum (WLAN, Bluetooth, etc.). Wireless technologies used in an industrial environment must be able to coexist without disrupting each other. If multiple networks operate in one plant, a frequency management should be applied as part of administration.
3.1.2 Antenna Characteristics

Before mounting the device, you should consider the antenna characteristics and the propagation of the radio waves. The following diagrams show the antenna gain in two different planes.

Figure 3.1 Antenna gain (side view, 2450 MHz, dBi)

Figure 3.2 Antenna gain (top view, 2450 MHz, dBi)
3.1.3 Examples for Good and Poor Positioning

Figure 3.3 Wave propagation, schematic representation (alpha = approx. 45°, may vary considerably)

1. Weaker signal above and below
2. Stronger signal sideways

Figure 3.4 Good positioning: Devices are within each other's antenna range
3.2 Mounting the Device

The WirelessHART adapter can be mounted in one of three ways:

- direct connection to the field device,
- separate from the field device, but connected by a cable,
- when used as a repeater, as an autark unit.

Danger!
Explosion hazard

If the cable glands are not fitted correctly, the IP degree of protection cannot be ensured and the electronic components can be exposed to an explosive atmosphere.

Check cable glands:

- all screws of the housing / housing cover must be tightened with the appropriate torque
- only cables of the appropriate size must be used in the cable glands
- all cable glands must be tightened with the appropriate torque
- all seals must be undamaged and fitted correctly
- all empty cable glands must be sealed with appropriate plugs

Direct connection

The direct connection to a field device is made by means of an adapter piece which is screwed into the cable entry at the side of the adapter. See chapter 3.2.1
Separate mounting

The adapter can be mounted on a wall (see chapter 3.2.2), post (see chapter 3.2.3) or other object, using the adapter wall/pipe mounting kit, which is available as an accessory. The connection to the field device is made with standard installation cable and two cable glands. It is recommended that the blind plug be left in place until the electrical connection is made.

It is recommended that the WirelessHART adapter be installed separate from a field device when:

- there is insufficient space at the measuring point to mount the adapter on the field device,
- the signal reception at the measuring point is too weak for correct operation,
- the measuring point is subject to vibration above the permissible limits.

Supplied parts

Depending on the order, the following parts may be supplied:

- adapter piece for connection to a field device with a M20 cable entry,
- adapter piece for connection to a field device with a G 1/2 cable entry,
- adapter piece for connection to a field device with a NPT 1/2 cable entry,
- adapter piece for connection to a field device with a NPT 3/4 cable entry,
- M20 cable gland for separate mounting,
- wall/pipe mounting kit.

3.2.1 Installation on a Field Device

Required tools:

- Metric spanner AF 24 (SW 24) for the connection adapter
- Metric spanner AF 25 (SW 25) for the counternut
Mounting the adapter directly on a field device

1. Remove the blind plug from the cable entry at the side of the adapter.
2. Push a Viton gasket on either side of the connection adapter supplied with the adapter.
3. Using a spanner, screw the connection adapter tightly into the cable entry of the field drive (torque 5 Nm + 1 Nm).
4. Loosen the counternut on the adapter.
5. Insert the other end of the connection adapter into the cable entry of the adapter and screw tight (torque 5 Nm + 1 Nm).
6. Align the adapter so that the antenna is vertical.
7. With the cable entry nut held with a spanner, tighten the counternut (torque 7 Nm).

3.2.2 Mounting to a Wall

As an addition to the tools already listed (see chapter 3.2.1), an M4 Allen key/bit is required to tighten the mounting bracket screws.
Mounting to a wall with mounting bracket

1. Mount the mounting bracket at a suitable position on the wall.
2. Unscrew and remove the counternut.
3. Thread the cable entry through the hole in the mounting bracket such that the antenna is on the side farthest away from the wall.
4. Remount the counternut and screw until the adapter is loosely held.
5. Align the adapter so that the antenna is vertical.
6. With the cable entry nut held with a spanner, tighten the counternut (torque 7 Nm).

3.2.3 Mounting to a Pipe

**Note!**
The maximum pipe diameter for pipe mounting is 70 mm.

Mounting to a Pipe

1. Mount the pipe mounting bracket at a suitable position on the pipe and screw tight (torque min. 5 Nm).
2. Using the four screws supplied, screw the mounting bracket to the pipe mounting bracket (torque 4 Nm + 1 Nm).
3. Unscrew and remove the counternut.
4. Thread the cable entry through the hole in the mounting bracket such that the antenna is on the side farthest away from the wall.
5. Remount the counternut and screw until the adapter is loosely held.
6. Align the adapter so that the antenna is vertical.
7. With the cable entry nut held with a spanner, tighten the counternut (torque 7 Nm).

3.3 Electrical Connection to other Devices

The *WirelessHART* adapter can be connected to the following device types/configurations.

- Field device operating in a control loop without communication resistor
- Field device operating in a control loop with communication resistor
  
  This configuration is used for HART multidrop with 2, 3, or 4 devices
- Two-wire field device operating independently with power supplied by the adapter
- Four-wire field device operating independently with power supplied by an external source

The devices are connected to the terminal block located inside the adapter housing.

![Terminal block diagram](image)

**Figure 3.9** Terminal block (1 ... 6) and terminals for Ex ia certified HART modem (7 + 8)

---

**Caution!**

Loss of intrinsic safety

If **Ex i** protected circuits have been operated with non-intrinsically safe circuits, they must no longer be used as **Ex i** protected circuits.

To maintain the **Ex i** rating of the *WirelessHART* adapter, use an **Ex i** rated HART modem to communicate with the *WirelessHART* adapter.

<table>
<thead>
<tr>
<th>Terminal</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Device supply</td>
</tr>
<tr>
<td>2</td>
<td>HART / 4 ... 20 mA</td>
</tr>
<tr>
<td>3</td>
<td>External Supply / GND</td>
</tr>
<tr>
<td>4, 5, 7</td>
<td>HART high impedance</td>
</tr>
<tr>
<td>6, 8</td>
<td>High impedance GND</td>
</tr>
</tbody>
</table>
3.3.1 Wiring Diagrams

**Control loop without communication resistor**

In this configuration, the field device is powered externally by a PLC, Remote I/O, or DC power supply and outputs a 4 ... 20 mA signal.

The adapter provides the following functions:

- Current measurement via 4 ... 20 mA interface
- HART digital communication, if supported by the connected device

For communication with the adapter, an Ex ia certified HART modem can be connected to terminals 5/7 and 6/8.

*Note!*

The connection is made across the 270 \( \Omega \) communication resistor of the adapter.

The circuits in the following 2 figures are electrically identical as terminal 4 and 5 are connected internally.

→ see Figure 3.10 on page 22

→ see Figure 3.11 on page 23

For loops with two signal lines, the adapter should be wired as shown in the following figure.

![Connection of adapter to a control loop without communication resistor](image)

Figure 3.10 Connection of adapter to a control loop without communication resistor

1. PLC, Remote I/O, DC power supply without communication resistor
2. Field device (passive)

For loops with only one signal line (common ground), the adapter should be wired as shown in the following figure.
In this configuration, the field device is powered externally by a PLC, Remote I/O or DC power supply and outputs a 4 ... 20 mA signal. Alternatively it is used in HART multidrop mode. The adapter provides the following functions:

- HART digital communication

For communication with the adapter, an Ex ia certified HART modem can be connected to terminals 5/7 and 6/8.

**Note!**

The circuits in the following 2 figures are electrically identical as terminal 4 is connected internally to terminal 5 and terminal 3 is connected internally to terminal 6.

→ see Figure 3.12 on page 24
→ see Figure 3.13 on page 24

**Existing installations:** For existing installations, we recommend that the adapter is wired as shown in the following figure.
New installations: For new installations, we recommend that the adapter is wired as shown in the following figure.

Two-wire device powered by adapter

In this configuration, the field device is operating independently and is powered by the adapter. The adapter provides the following functions:

- Current measurement via 4 ... 20 mA interface,
- HART digital communication, if supported by the connected device.
**Note!**
For HART devices, we recommend that the device is operated in multidrop mode to prolong battery life. In this case, a polling address between 1 and 14 is set and the device outputs a constant current of 4 mA.

![Figure 3.14 Connection of loop-powered device to active adapter](image)

1. Field device (passive)

**Four-wire device**
In this configuration, the field device is operating independently and is powered by an external power source. The adapter provides the following functions:
- Current measurement via 4 ... 20 mA interface,
- HART digital communication, if supported by the connected device.

![Figure 3.15 Connection of active four-wire device to passive adapter](image)

1. Four-wire field device (active)
2. External Power Source

### 3.3.2 Connecting Cables

**Required tools:**
- Phillips screwdriver PZ1 to open the adapter cover,
- Screwdriver with 2.5 mm blade to make the connections.
If the adapter is mounted on the field device, use the two wires supplied to make the connection.

If the adapter is to be mounted separately, standard installation cable can be used. If strong electromagnetic interference is to be expected (machines, walkie-talkies), use shielded, twisted pairs. Connect the shield to the ground terminal.

**Figure 3.16 Opening the cover**

1  Captive screws

**Figure 3.17 Cable entries**

1  Primary cable entry (blind plug seals adapter when cable entry not in use)
2  Secondary cable entry with M20x1.5 cable gland

**Note!**
The secondary cable entry in the base of the adapter should be used in following situations:
- if the adapter is mounted separately on a wall or pipe
- for the power cables when the field device is operating in a control loop
Direct wiring (adapter mounted on field device)

When the adapter is mounted directly on the field device, the wiring is done through the connection adapter as follows.

1. Open the housing of the adapter by unscrewing the four captive screws. Also open the connection compartment of the field device.
2. Thread the two wires supplied through the connection adapter (primary cable entry).
3. Connect the WirelessHART adapter according to the appropriate wiring diagram.
4. If an external power line is to be connected, use the secondary cable entry.
5. Connect the field device according to the instructions in its operating manual.
6. If the devices are not to be commissioned immediately after connection, close the housing and field device connection compartment.
7. In order to obtain optimal sealing of the adapter housing, tightened the screws to a torque of 0.5 Nm.

Wiring (adapter mounted separately)

1. Open the housing of the adapter by unscrewing the four captive screws. Also open the connection compartment of the field device.
2. Using a M20x1.5 cable gland, thread the connecting or power cable through the secondary cable entry into the adapter.
3. Connect the WirelessHART adapter according to the appropriate wiring diagram.
4. Pull the cable taut. The adapter cover is a tight fit and a trapped cable may prevent proper closure.
5. Tighten the cable gland.
6. Connect the field device according to the instructions in its operating manual.
7. If the devices are not to be commissioned immediately after connection, close the housing and field device connection compartment.
8. In order to obtain optimal sealing of the adapter housing, tightened the screws to a torque of 0.5 Nm.
9. Tighten the cable gland and, if required, the blind plug to a torque of 3.5 Nm.

Electrical Specification

<table>
<thead>
<tr>
<th>Loop power for field device (Terminal 1):</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offload voltage</td>
</tr>
<tr>
<td>Current</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>4 ... 20 mA/HART input (Terminal 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>High impedance HART interface (Terminals 4, 5, 6)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input impedance</td>
</tr>
<tr>
<td>DC input impedance</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Maximum terminal voltage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Across Terminals 2 + 3:</td>
</tr>
<tr>
<td>Across Terminals 5 + 6:</td>
</tr>
</tbody>
</table>

**Note!**

Due to the internal communication resistor, the supply voltage of the field device depends upon the offload voltage and the current signal.
4 Commissioning

**Warning!**
Do not operate the power switch in a hazardous location.

4.1 Connected HART Device(s)

It is recommended that the connected HART device is commissioned before the adapter.

**Note!**
- It is not necessary to assign different HART addresses for different adapters. The addresses used on the network also incorporate the serial number of the adapters and are automatically unique for each adapter.
- 4 ... 20 mA devices require no pre-configuration. The scaling and any linearization are configured within the adapter DTM.

Parameterizing the field device

1. Connect a configuration tool, for example, PACTware™ to the field device using a HART modem.
   If the adapter shall power the field device, first power the adapter by connecting the battery and then continue with this step. During the start-up phase of the adapter, the field device goes on and off again. If the field device does not power up again after the communication started, power the field device for 5 minutes (time can be configured in adapter DTM) by pushing the adapter button for more than 10 seconds until the red LED flashes.
2. Set the following parameters for the field device:
   - HART address: sets the output mode of the device (0 = 4 ... 20 mA; 1 ... 15 = HART)
     - If the device is connected to an existing 4...20 mA loop, use the address = 0
     - Otherwise use address = 1 for HART multidrop mode with a 4 mA current output.
     - If more than one HART device is connected (up to 4 are allowed if externally powered), each must have a unique address between 1 and 14, e.g. 1, 2, 3, 4.
   - Device Tag: identifies the measuring point.
   - Long Tag: identifies the device on the wireless network.
     Long Tags are available from HART Version 6.0 onwards. For earlier versions, for example, HART 5 instruments, use the Message instead.

4.2 Connecting the Battery

**Danger!**  
Batteries in hazardous areas

Batteries from Pepperl+Fuchs for this device may be brought into hazardous areas. However, always check if the battery is intact before transporting it into hazardous areas. Always transport batteries enclosed inside their original packages or already installed inside the device.

**Danger!**  
Loss of intrinsic safety

The use of batteries other than specified voids the qualification for use in hazardous areas. Only use batteries of type W-BAT-B2-Li from Pepperl+Fuchs.
Connecting the battery

The adapter is delivered with the battery unit installed but not connected. It is connected as follows.

1. If necessary, open the adapter cover by unscrewing the four captive Phillips screws. See Figure 3.16 on page 26
2. Plug the battery cable into the battery connector.

---

**Danger!**
Possible damage because of wrong battery

The use of batteries other than specified may cause damage to the device.

Only use batteries of type W-BAT-B2-Li from Pepperl+Fuchs.

---

**Warning!**
Caustic battery acid

Leaking battery acid can cause personal injury and damage to the device.

- Never use batteries that are leaking.
- Never use batteries with external damage such as dents or deep scratches, even if no battery acid is leaking.

---

**Danger!**
Electrostatic discharge hazard

The device contains non-conductive plastic parts. Care must be taken when operating the installed device because of possible electrostatic charges. Electrostatic charged surfaces may cause an ignition spark.

Electrostatic charges must be avoided. For example, do not rub the device and never clean plastic surfaces with a dry cloth. Always use a damp cloth instead.

---

**Note!**
You may open the housing and connect/disconnect the battery in Zone 1.
As soon as the battery is connected, the adapter initializes.
- The occupation of the terminals is checked.
- The type of device connected is checked.
- If a HART device is connected, its data are read into the adapter.
- The LEDs indicate the status of the device. See chapter 6.1.1
- The adapter is now ready for commissioning.

4.3 Initial Configuration via HART Modem

For security reasons, the Network ID and Join Key must be configured through a wired connection before the device can connect itself to a WirelessHART network. To do so, you can use an Ex ia certified HART modem that connects to a PC/Laptop using the USB interface or the RS232 interface.

Caution!
Loss of intrinsic safety

If Ex i protected circuits have been operated with non-intrinsically safe circuits, they must no longer be used as Ex i protected circuits.

To maintain the Ex i rating of the WirelessHART adapter, use an Ex i rated HART modem to communicate with the WirelessHART adapter.

Connecting the device to a PC/Laptop via HART modem

Install the HART modem drivers on your PC/Laptop according to the instructions given by the manufacturer.

1. If necessary, open the housing cover by unscrewing the four captive Phillips screws. → see Figure 3.16 on page 26
2. Connect the Ex ia certified HART modem to terminals 7 + 8. You can also use terminals 5 + 6 as these terminals are connected internally. If the HART modem has an internal communication resistor, this should be switched off at the first attempt to communicate. If communication fails, a resistor may be required. See chapter 8.

3. Switch on your PC/Laptop.

4. Plug the HART modem into the USB/RS232 port.

   → If using the USB port, your PC/Laptop should recognize the HART modem automatically. If using the RS232 port, proceed with the next step.

5. To find out to which COM port the HART modem is connected, open the Windows® device manager. For example, if using Windows® XP, click Start > Settings > Control Panel > System > Hardware > Device Manager, or if using Windows® 7, click Windows Icon > Control Panel > System > Device Manager.

   → Under Ports (COM & LPT) you see the HART modem and the COM port assigned to it. You will need the COM port number later on.

4.4 DTM Software

4.4.1 Downloading the Required Software

Required software:

- Microsoft® .NET Framework
- PACTware™ Framework
- WirelessHART DTM
  The DTM collection including WirelessHART device DTMs and Ethernet communication DTM.
- HART CommDTM
  The HART CommDTM has to be installed separately. It is required for wired communication via HART modem. The HART CommDTM supports both FSK (i.e. HART modem) and RS-485 interfaces.

**Note!**

If one of the software components is already installed on your system, the installation may be omitted.

Where to download the required software?

2. Click Products.
3. Click Software.
4. Download the software components Microsoft® .NET Framework, PACTware™, WirelessHART DTM and HART CommDTM. You might need to scroll down the page to find the required component.
5. Unzip the downloaded files and store the data to your local hard drive.

4.4.2 Installing the DTM Software Components

Your computer must meet the following requirements in order to run PACTware™ and the device DTM:

- Operating system: Windows® 2000 Service Pack 4, Windows® XP Service Pack 1/2/3 or Windows® Vista
- Software: Microsoft® .NET Framework Release 1.1 Service Pack 1
Processor: 500 MHz or faster
Memory: 256 MB RAM or more
Disk space: 200 MB or more
Graphics resolution: 1024 x 768 or higher
Administrator privileges to enable software installation

Install the DTM Software Components

1. Install the Microsoft® .NET Framework by starting the corresponding setup.exe file and following the installation instructions given on the screen.
2. Install PACTware™ by starting the corresponding setup.exe file and following the installation instructions given on the screen.
3. Install the Wireless HART DTM collection by starting the corresponding setup.exe file and following the installation instructions given on the screen.
4. Install the HART CommDTM by starting the corresponding setup.exe file and following the installation instructions given on the screen.
   ➞ You have installed the required software.

4.4.3 Updating the DTM Catalog

Once you have installed the FDT base application and the Device Type Manager (DTM) on the computer, the FDT base application's DTM catalog must be updated. The PACTware™ DTM catalog is called "Device Catalog" and is normally automatically updated when PACTware™ is launched.

If PACTware™ does not update the device catalog automatically, proceed as follows.

Updating the Device Catalog

1. Start PACTware™.
2. Select View > Device Catalog or click Device Catalog in the icon bar.
   ➞ The Device Catalog window opens.
3. Click Update Device Catalog to update the device catalog.
4. Click Yes to continue.
   ➞ The updated device catalog appears.

4.5 Creating a new Project in PACTware™

4.5.1 Creating a New Project

Creating a new project in PACTware™?

Select File > New or click Create New Project.
   ➞ A new, unnamed project appears in the main window. The project initially consists of the entry HOST PC.

4.5.2 Adding the Communication DTM

A communication DTM is an interface between the FDT frame application and the device DTM. The communication DTM enables communication between the device DTM and the device connected to the PC.

For the PC to communicate with the device via the HART modem, a HART communication DTM has to be added to the PACTware™ project.
Adding HART Communication DTM

Note!
The HART Communication DTM is not included in the WirelessHART DTM Collection. It can be downloaded separately from www.pepperl-fuchs.com.

1. Select the entry HOST PC in the project view of your PACTware™ project.
2. Choose Device > Add device or click the Add device icon on the toolbar.

The Device for window appears.

3. Select the entry HART communication.
4. Click OK.

The HART communication DTM is added to the project.

5. To edit the parameters, double-click on the HART communication DTM.

The parameter window appears.

Note!
The HART Communication DTM is not included in the WirelessHART DTM Collection. It can be downloaded separately from www.pepperl-fuchs.com.
Figure 4.4 Parameter window of HART communication DTM

6. Set the parameters according to the following table.

7. Click **OK** to save the changes and to close the parameter window.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Communication interface</strong></td>
<td>Set this parameter to <strong>HART modem</strong>.</td>
<td><strong>HART modem</strong></td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Set this parameter to the COM port your HART modem is connected to.</td>
<td><strong>COM1</strong></td>
</tr>
<tr>
<td><strong>Master</strong></td>
<td>Set this parameter to <strong>Secondary master</strong>.</td>
<td><strong>Primary Master</strong></td>
</tr>
<tr>
<td><strong>Preamble</strong></td>
<td>Number of preambles for HART communication.</td>
<td><strong>5</strong></td>
</tr>
<tr>
<td><strong>Number of communication retries</strong></td>
<td>The number of retries for HART communication in case of an error.</td>
<td><strong>3</strong></td>
</tr>
<tr>
<td><strong>Start address</strong></td>
<td>Here the address range is set, in which the HART Communication DTM is to search for HART devices connected to the HART modem. Set this parameter to <strong>Start address = 14, End address = 15</strong>. 15 is the default value of the adapter.</td>
<td><strong>0</strong></td>
</tr>
<tr>
<td><strong>End address</strong></td>
<td></td>
<td><strong>15</strong></td>
</tr>
<tr>
<td><strong>Multimaster and Burst mode support</strong></td>
<td>Activate this check box.</td>
<td><strong>deactivated</strong></td>
</tr>
</tbody>
</table>

4.5.3 Adding Device DTM

Performing a HART Scan

1. In the project view, right-click on the entry of the communication DTM.
2. Choose **Connect**.
3. Choose **Additional functions > Scan list**.
4. If the scan does not begin automatically, click **Refresh**.
   - The detected field devices are displayed in the **Scan list** window.
Adding the Device DTM

You may add the adapter to your PACTware™ project in various ways (see PACTware™ documentation). One of them is described in the following.

1. In the project view, right-click on the entry of the HART communication DTM.
2. To add the device DTM, choose Add device.

哔 The Device for window opens.

3. Select WHA-ADP.
4. Click OK.

哔 The device DTM is added to the project. You may continue with parameterizing the adapter as described in the following.

5. Remember to save your PACTware™ project from time to time (File > Save).

4.6 Joining the Wireless Network

To connect itself to the WirelessHART network, the device must carry the correct Network ID and Join Key. The Network ID and Join Key have to be configured using a wired connection before the device joins the WirelessHART network for the first time.

To enter Network ID and Join Key, the following requirements have to be met.

- A PC/Laptop is connected to the device using a HART modem.
- A PACTware™ project containing the HART communication DTM and the device DTM has been created.

In the joining phase the device sends a join request packet to the network manager. If the new device can be authenticated, the network manager responds with an activation packet and sets up links between the new device and other existing nodes. Furthermore, the new device receives a 128 Bit encryption key.
Entering Network ID and Join Key

1. In the PACTware™ project, right-click the DTM of the device that shall join the WirelessHART network.

![Figure 4.5 DTM of the WirelessHART Temperature Converter in the PACTware™ project view](image)

2. Choose Connect. A connection is established.
3. To open the online parameterization window, right-click the device DTM and choose Parameter > Online parameterization. The online parameterization window appears.
4. In the online parameterization window, choose Wireless Communication. The wireless communication parameters are displayed.
5. Enter the Network ID into the Network Identification field and press Enter to confirm the new value.
6. Enter the Join Key into the 4 Join Key fields and press Enter to confirm the new value.
7. Click Execute Join. The device attempts to join the wireless network. The connection status is indicated by Join Status.
5 Configuration

5.1 Configuration Options

We recommend that you configure the device on the shop floor via a wired connection using a HART modem. See chapter 4.3

1. Define all basic settings such as wireless communication parameters (Network ID, Join Key, Join Mode) and identification parameters (Long Tag, Polling Address) using a HART modem.

2. Make the device join the WirelessHART network.

3. Once the device has joined the WirelessHART network, configure the burst mode parameters, event notifications, and other application settings using a HART modem.

4. Disconnect the HART modem and install the device in the field.

Once the device is installed in the field, you can change the configuration of the device via a wireless connection using the WirelessHART Gateway.

Wireless Configuration via the WirelessHART Gateway

We assume that the WirelessHART Gateway is installed and configured correctly according to the manual of the WirelessHART Gateway. Furthermore, we assume that the device to be configured has joined the WirelessHART network.

1. Start your PACTware™ project containing the device DTM of the WirelessHART Gateway.

2. In the project view, right-click on the entry WHA-GW.

3. To add the device DTM, choose Add device from the context menu.

   The Device for window opens.

4. Select the entry of the WirelessHART device you want to add to the PACTware™ project.

5. Click OK.

   The device DTM is added to the project.

Now you can continue with parameterizing the device as if you had a wired connection. See chapter 5.2
5.2 Online and Offline Parameterization (PACTware)

The concept of online and offline parameterization applies only to configuration via device type manager (DTM) with PACTware.

- **Offline Parameterization** (not connected to device)
  - If there is no active connection to the device, you can edit and save the data that is stored locally in PACTware. You can transfer the local data to the device, as soon as a connection to the device has been established.

- **Online Parameterization** (connected to device)
  - If there is an active connection to the device, you can directly edit the data that is stored on the device. Parameter changes are immediately stored on the device.

**Note!**

Data that is edited and stored on the device during online parameterization is **not** automatically synchronized with the offline data in the PACTware project. If you change device parameters in online mode, the data in PACTware differs from the data on the device. To make sure the data in PACTware matches the data on the device after online parameterization, load the data from the device into the PACTware project.

### Offline Parameterization

1. Right-click the device in the PACTware project view.
2. Choose **Parameter > Offline Parameterization**.
   - The window containing the offline data record appears.
3. Modify a parameter by typing in a new value or choosing a new value from the drop-down list.
4. To accept the new value, press **Enter**.
5. After all parameter changes have been made, save your project by choosing **File > Save**.
6. To write the new offline configuration to the device, right-click the device in the project view and choose **Connect**.
   - A connection to the device is established.
7. Right-click the device again and choose **Store to device**.
   - The new configuration is stored in the device.
Online Parameterization

**Note!**
Some options are only available during online parameterization. These options are pointed out in the relevant sections.

1. Right-click the device in the PACTware project view.
2. Select **Connect**.
   - A connection to the device is established.
3. Right-click the device in the PACTware project view.
4. Select **Parameter > Online Parameterization**.
   - The window containing the online data opens and the data is read from the device.
5. Modify a parameter by typing in a new value or choosing a new value from the drop-down list.
6. To accept the new value, press **Enter**.
   - The new value is stored in the device immediately.
7. After all parameter changes have been made, you can load the online configuration into the PACTware project. To do this, right-click on the device entry in the project view and choose **Load from device**.
8. Save your project by choosing **File > Save**.

### 5.3 Identification Parameters

The identification parameters provide various information about the device and identify the device within the network.

![Identification parameters](image)
## Identification Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Long Tag</strong></td>
<td>Identifies the device in a WirelessHART network. Enter up to 32 characters.</td>
<td>–</td>
</tr>
<tr>
<td><strong>Device Tag</strong></td>
<td>Identifies the field device within the process plant. Enter up to 8 characters.</td>
<td>–</td>
</tr>
<tr>
<td><strong>Descriptor</strong></td>
<td>Further description of the device. Enter up to 16 characters.</td>
<td>–</td>
</tr>
<tr>
<td><strong>Date Code</strong></td>
<td>Date of last parameter change. Format: DD.MM.YYYY</td>
<td>01.04.2009</td>
</tr>
<tr>
<td><strong>Message</strong></td>
<td>User defined message. Enter up to 32 characters.</td>
<td>–</td>
</tr>
<tr>
<td><strong>Polling Address</strong></td>
<td>HART address of the adapter on the wired interface, valid range 0 ... 63. Since the long tag and MAC address are used to identify the device in the WirelessHART network, it is not necessary to give different devices different polling addresses.</td>
<td>15</td>
</tr>
</tbody>
</table>
| **Country Code**| Select the country code of the country in which the device is operated from this drop-down list.  
  ■ Governs the signal strength that can be set for the device  
  ■ Determines the preset value for "SI Units only" | –       |
| **SI Units only**| Selects the unit set to be used by the adapter.  
  ■ Unit codes restricted to SI units only: only SI units are displayed  
  ■ No restrictions: Both metric and US units are displayed | –       |
5.4 Wireless Communication Parameters

The wireless communication parameters apply to the WirelessHART network that the device will join.

![Image of Wireless Communication Parameters](image_url)

Figure 5.5 Wireless communication parameters

**Note!**

If using the DTM and PACTware to configure the WirelessHART gateway, the following data is available only during online parameterization.
### Wireless Communication Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Identification</strong></td>
<td>Unique Network ID of the WirelessHART network the device is supposed to join. Enter up to 5 digits (0 ... 99999).</td>
<td>–</td>
</tr>
</tbody>
</table>
| **Wireless Operation Mode** | Indicates current mode of operation of the device:  
- Idle: waiting for trigger to start join procedure  
- Active Search: searching for neighboring WirelessHART devices  
- Negotiating: connection parameters are being exchanged with the network manager (gateway)  
- Quarantined: network manager has temporarily stopped the device from joining the network  
- Operational: device is connected to the network  
- Suspended: network manager has permanently stopped the device from joining the network  
- Deep Sleep/Ultra-low Power/Passive Search: adapter is inactive | –       |
| **Radio Power** | Power of the radio signal emitted by the device. The selection and the default value depend on the Country Code parameter. | 0 dBm   |
| **Join Key Part x of 4** | The join key is the password for the network the device is to join. Enter 32 hexadecimal characters. There are four text fields that can hold eight characters each. | –       |
| **Join Shed Time** | Time (hh:mm:ss) that the device is given to join the network after the Join Mode condition has been fulfilled. After this time has elapsed, the device will keep on trying to join the network using a low duty-cycle receive mode to reduce energy consumption (yellow COM LED off). | 00:40:00 |
| **Join Mode** | Joining behavior of the device:  
- Do not attempt to join  
- Join now  
- Attempt to join immediately on powerup or reset | Attempt to join immediately ...

**Execute Join**  
Press the button to store the Join Shed Time and Join Mode parameters to the device. The device will attempt to join the network in the way that is specified in Join Mode.

- **Join Status** | Indicates the current status when joining the network. Possible messages:  
- Network Packets Heard  
- ASN Acquired  
- Synchronized to time slot  
- Advertisement Heard  
- Join Requested  
- Join Retrying  
- Join Failed  
- Authenticated  
- Network Joined  
- Negotiating Network Properties  
- Normal Operation Commencing | –       |
5.5 Wired Communication Parameters

The Wired Communication parameters pertain to the HART communication between the adapter and and HART device(s) connected to it. Up to four HART devices can be connected in multidrop mode to the adapter, each requiring a different HART address.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total number of Neighbors</td>
<td>Number of WirelessHART devices to which a connection has been established.</td>
<td>–</td>
</tr>
<tr>
<td>Number of Advertising Packets received</td>
<td>Number of advertising packages received by the device.</td>
<td>–</td>
</tr>
<tr>
<td>Number of Join Attempts</td>
<td>Number of attempts the device has made to join the network.</td>
<td>–</td>
</tr>
<tr>
<td>Active Advertising Shed Time</td>
<td>Time in hh:mm:ss that the device is given to advertise its presence to its neighbors in order that they can join the network quickly.</td>
<td>00:40:00</td>
</tr>
<tr>
<td>Request Active Advertising</td>
<td>Pressing this button will cause the device to advertise its presence for the period Active Advertising Shed Time.</td>
<td>–</td>
</tr>
<tr>
<td>Number of Neighbors Advertising</td>
<td>Number of neighbors that are advertising their presence and have been detected by the device.</td>
<td>–</td>
</tr>
</tbody>
</table>

Figure 5.6 Wired communication parameters
## Wired Communication Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Polling Address</strong></td>
<td>HART address of the device set in <strong>Identification</strong>.</td>
<td>–</td>
</tr>
<tr>
<td><strong>Master Type</strong></td>
<td>HART master role to be assumed by the adapter.</td>
<td>Primary Master</td>
</tr>
<tr>
<td></td>
<td>■ Primary master: The connected HART device has no other permanent master.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Secondary master: The connected HART device communicates with a permanent HART primary master, e.g. PLC.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If a handheld device or PACTware™ are connected temporarily to the HART device when the adapter is operational, they must have the role of secondary master.</td>
<td></td>
</tr>
<tr>
<td><strong>Preambles</strong></td>
<td>Number of preambles sent at start of HART frame to synchronize communication with the connected HART device. All connected devices must have the same settings. Valid range: 5 ... 20.</td>
<td>5</td>
</tr>
<tr>
<td><strong>Retries</strong></td>
<td>Number of times the adapter tries to establish communication with a connected HART device before it reports a communication error</td>
<td>3</td>
</tr>
<tr>
<td><strong>Lowest Scan Address</strong></td>
<td>Address from which the adapter starts scanning for connected HART devices.</td>
<td>0</td>
</tr>
<tr>
<td><strong>Highest Scan Address</strong></td>
<td>Address at which the adapter stops scanning for connected HART devices.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>■ A HART device providing a 4 … 20 mA output in a control loop will have the address 0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ Normally a single HART device powered by the adapter will have the address 1, as this ensures it is operating in multidrop mode (current 4 mA)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ For a multidrop bus (max. 4 devices) enter the highest address.</td>
<td></td>
</tr>
</tbody>
</table>
### Configuration

**Scan Subdevices**
Press the button to scan the connected HART devices. The devices found, together with their parameters, are displayed in the Field Device Table. If the HART device is disconnected or its configuration changed, a new scan must be made. Note: A scan is made every time the adapter is powered up after connection of the battery – the table then fills automatically.

**Field Device Table**
Displays the parameters read from the HART device by the scan.
- Manufacturer ID: Manufacturer of connected device.
- Expanded Device Type Code: Device identifier as per HART.
- Device ID: Manufacturer’s device identifier.
- Universal Command Revision Level: HART revision supported.
- Long Tag: Long tag of device (Message for HART revision < 6.0).
- Start-Up Voltage: Voltage required to start the connected device.
- Start-Up Time: Time required for the device to wake-up
- Start-Up Current: Current consumed on starting the device
- Lead Time: Time that elapses between start-up and the point at which the device can deliver valid values. See chapter 5.8

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Subdevices</td>
<td>Press the button to scan the connected HART devices. The devices found, together with their parameters, are displayed in the Field Device Table. If the HART device is disconnected or its configuration changed, a new scan must be made. Note: A scan is made every time the adapter is powered up after connection of the battery – the table then fills automatically.</td>
<td></td>
</tr>
</tbody>
</table>
| Field Device Table | Displays the parameters read from the HART device by the scan.  
  - Manufacturer ID: Manufacturer of connected device.  
  - Expanded Device Type Code: Device identifier as per HART.  
  - Device ID: Manufacturer’s device identifier.  
  - Universal Command Revision Level: HART revision supported.  
  - Long Tag: Long tag of device (Message for HART revision < 6.0).  
  - Start-Up Voltage: Voltage required to start the connected device.  
  - Start-Up Time: Time required for the device to wake-up  
  - Start-Up Current: Current consumed on starting the device  
  - Lead Time: Time that elapses between start-up and the point at which the device can deliver valid values. See chapter 5.8 |         |
5.6 Device Variable Mapping

The adapter can output the value and status of several variables, but a maximum of only four variables can be published on the network. The device variable mapping is used to configure these variables.

![Device Variable Mapping](image)

Figure 5.7 Device variable mapping

The variables that can be set as SV, TV and QV are as follows:

- Temperature
- Temperature min
- Temperature max
- Battery voltage
- Consumer energy
- RSL of best neighbour (RSL = Radio Signal Level)
- RSL of second best neighbour
- Battery voltage with load
- Battery voltage without load during battery test
- Normalized Consumer Energy
- Estimated Lifetime
Device variable mapping

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Primary Variable</td>
<td>Variable to be output as primary variable (PV)</td>
<td>Loop Current (fixed)</td>
</tr>
<tr>
<td>Primary Variable Unit</td>
<td>Engineering units of the primary variable</td>
<td>mA (fixed)</td>
</tr>
<tr>
<td>Select Secondary Variable</td>
<td>Variable to be output as secondary variable (SV)</td>
<td>Temperature</td>
</tr>
<tr>
<td>Secondary Variable Unit</td>
<td>Engineering units of the secondary variable (fixed)</td>
<td>°C</td>
</tr>
<tr>
<td>Select Tertiary Variable</td>
<td>Variable to be output as tertiary variable (SV)</td>
<td>Battery Voltage</td>
</tr>
<tr>
<td>Tertiary Variable Unit</td>
<td>Engineering units of the tertiary variable (fixed)</td>
<td>V</td>
</tr>
<tr>
<td>Select Quaternary Variable</td>
<td>Variable to be output as quaternary variable (SV)</td>
<td>Normalized Consumer Energy</td>
</tr>
<tr>
<td>Quaternary Variable Unit</td>
<td>Engineering units of the quaternary variable (fixed)</td>
<td>Ah</td>
</tr>
</tbody>
</table>

5.7 Application Settings

5.7.1 4 ... 20 mA

When a HART device is connected to the adapter, all parameters are read via the digital signal. It is possible, however, to connect a 4 ... 20 mA device to the adapter. In this case the 4 ... 20 mA signal can be scaled as desired in the DTM and a linearization can be made if necessary. In addition, current values can be set which correspond to the limits of the proportional range and the fault signal of the device. Should these current limits be violated, an appropriate warning or alarm signal is transmitted by the adapter.
### Device variable mapping

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary Variable Unit</strong></td>
<td>The unit of the primary variable supplied by the 4 ... 20 mA device. The selection changes the units of the scaling parameters.</td>
<td>mA</td>
</tr>
<tr>
<td><strong>Linearization Mode</strong></td>
<td>Determines how the current input will be converted to the output.</td>
<td>Linear</td>
</tr>
<tr>
<td>■ Linear: Proportional scaling across the set range</td>
<td></td>
<td></td>
</tr>
<tr>
<td>■ Special curve: Scaling according to the table in <strong>Linearization</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Primary Variable Upper Range Value (20 mA)</strong></td>
<td>Output value assigned to the 20 mA current input</td>
<td>20 mA</td>
</tr>
<tr>
<td><strong>Primary Variable Lower Range Value (4 mA)</strong></td>
<td>Output value assigned to the 4 mA current input</td>
<td>4 mA</td>
</tr>
<tr>
<td><strong>Input Damping</strong></td>
<td>Damping factor for the current input in seconds (valid range 0 ... 255)</td>
<td>0</td>
</tr>
<tr>
<td><strong>Upper Fault-Current Value</strong></td>
<td>Max. current output by 4 ... 20 mA device when in fault condition. The adapter outputs an alarm if the current input reaches this level.</td>
<td>22 mA</td>
</tr>
</tbody>
</table>
### Linearization parameters

If the linearization mode "Special Curve" is selected, the "Linearization" leaf must be opened:

- Up to 32 value pairs can be entered
- X values must be entered in increasing order, Y values must rise or fall monotonically (red = error)
- Range end values must correspond to those in the 4-20 mA leaf
- A graphic shows the linearization curve

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upper Limit of Proportional Range</td>
<td>Upper limit value of proportional range. The adapter outputs a warning if the current input exceeds this level.</td>
<td>20.5 mA</td>
</tr>
<tr>
<td>Lower Limit of Proportional Range</td>
<td>Lower limit value of proportional range. The adapter outputs a warning if the current input drops below this level.</td>
<td>3.8 mA</td>
</tr>
<tr>
<td>Lower Fault-Current Value</td>
<td>Min. current output by 4 ... 20 mA device when in fault condition. The adapter outputs an alarm if the current input reaches or drops below this level.</td>
<td>3.6 mA</td>
</tr>
<tr>
<td>Trim Loop Current Zero</td>
<td>When pressed, calibrates the 4 mA signal of the connected device. 4 mA must be simulated or an &quot;empty&quot; calibration made.</td>
<td>–</td>
</tr>
<tr>
<td>Trim Loop Current Gain</td>
<td>When pressed, calibrates the 20 mA signal of the connected device. 20 mA must be simulated or a &quot;full&quot; calibration made.</td>
<td>–</td>
</tr>
</tbody>
</table>

![Image of linearization parameters](image-url)
Burst Mode Parameters

Burst mode is a special communication mode in which a HART slave device sends responses to a particular HART command on a predetermined, periodic schedule without being polled by the master. Normally, a HART slave device only responds when being polled by the master. When burst mode is used, a HART slave device can publish data (for example process values) independently in regular time intervals. Data can be sent as scheduled, or only if the value has changed by a significant amount or has not been updated within a default reporting time.

Up to 10 different burst modes can be set for the adapter or connected HART devices.

Note!

Battery lifetime

The more frequently burst messages are sent the more battery power is consumed, thus reducing battery lifetime.
# Burst Mode 1 ... 10 Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Burst Mode Control Code</strong></td>
<td>Switches burst mode on or off (&quot;Wireless&quot; = on). The following parameters in this table can only be edited if <em>Burst Mode Control Code</em> is set to &quot;Wireless&quot;. Otherwise they are grayed out. The field will also show &quot;Off&quot; if the parameters are downloaded when the adapter is not in the network. The parameters are retained and become active when the adapter joins the network.</td>
<td>Off</td>
</tr>
<tr>
<td><strong>Device Index</strong></td>
<td>Selects the device via its long tag for which the burst mode applies.</td>
<td>Not selected</td>
</tr>
<tr>
<td></td>
<td>- &lt;Adapter Long Tag&gt;: Adapter parameters are transmitted.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- &lt;Device Long Tag&gt;: Device parameters are transmitted.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For HART devices of Revision 5 or lower, the &quot;Message&quot; serves as the long tag. See chapter 4.1</td>
<td></td>
</tr>
<tr>
<td><strong>Period</strong></td>
<td>When the trigger mode is set to &quot;continuous&quot;, determines the period in hh:mm:ss that elapses between burst messages.</td>
<td>00:30:00</td>
</tr>
<tr>
<td></td>
<td>When the trigger mode is not set to &quot;continuous&quot;, determines the scan rate in hh:mm:ss for checking whether the trigger condition for a burst message is fulfilled.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The minimum setting is 8 seconds.</td>
<td></td>
</tr>
<tr>
<td><strong>Max. Period</strong></td>
<td>When the Trigger Mode is not set to &quot;continuous&quot;, determines the maximum period in hh:mm:ss that may elapse between two burst messages when the conditions for the trigger are not fulfilled.</td>
<td>01:00:00</td>
</tr>
<tr>
<td><strong>Trigger Mode</strong></td>
<td>Determines the event that triggers a burst message from the device.</td>
<td>Continuous</td>
</tr>
<tr>
<td></td>
<td>- Continuous: A burst message is published continuously at intervals determined by Period.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Window: a burst message is triggered when the source value deviates more than the specified trigger value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Rising: a burst message is triggered when the source value rises above the specified trigger value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Falling: a burst message is triggered when the source value falls below the specified trigger value.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- On-Change: a burst message is triggered when any value in the message changes.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>If the conditions are not met for Trigger Modes &quot;Window&quot;, &quot;Rising&quot;, &quot;Falling&quot; and &quot;On-Change&quot;, a burst message is sent at intervals determined by Max. Period.</td>
<td></td>
</tr>
<tr>
<td><strong>Device Variable Class (Trigger)</strong></td>
<td>Determines the device variable that is used to trigger the burst message, e.g. Temperature.</td>
<td>Not classified</td>
</tr>
<tr>
<td><strong>Unit Code (Trigger)</strong></td>
<td>Engineering unit used by the trigger variable, e.g. °C</td>
<td>Not used</td>
</tr>
<tr>
<td><strong>Trigger Level</strong></td>
<td>Value of the source variable which is used to trigger the burst message, e.g. 150°C</td>
<td>0</td>
</tr>
</tbody>
</table>
5.7.3 Event Notification

Event notification is a special application of a burst message and publishes changes in the device configuration and status, independent of data publishing supported in other burst mode commands. For events, the status included in the Device Status byte, Extended Device Status byte and Command 48 can be used. It is possible to specify a limited set of bits that will trigger event notification.

Event notifications have a low priority but carry a time stamp in order to indicate the first time when a notification occurred. Up to 5 different event notification messages can be defined in the leaves Event Notification 1 ... 5.

Each Event Notification window (1 ... 5) is subdivided into 3 tabs:

- Event
- Standard Event Mask
- Device-Specific Event Mask
### Event Tab

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Notification Control Code</td>
<td>Switches event notification on or off (&quot;Wireless&quot; = on). The following parameters in this table can only be edited if Event Notification Control Code is set to &quot;Wireless&quot;. Otherwise they are grayed out.</td>
<td>Off</td>
</tr>
</tbody>
</table>
| Device Index                        | Selects the device via its long tag for which the burst mode applies.  
  ▪ <Adapter Long Tag>: Adapter parameters are transmitted.  
  ▪ <Device Long Tag>: Device parameters are transmitted.  
  For HART devices of Revision 5 or lower, the "Message" serves as the long tag (see chapter 4.1).                                        | –       |
| Event Notification Retry Time       | Period between retransmissions of the event notification. The event notification continues to be retransmitted until an acknowledgement of the event is received.                                               | 00:30:00|
| Maximum Update Time                 | Maximum period in seconds that may elapse between successive event notifications. If no event occurs, the adapter will publish an event notification after this time has elapsed.                                      | 00:30:00|
| Event Debounce Interval             | The amount of time that a condition must persist before the event notification is sent out.                                                                                                               | 00:30:00|
| Event Status                        | Indicates whether a particular event notification has been sent and is still unacknowledged.  
  ▪ Configuration Changed Event pending  
  ▪ Device Status Event Pending  
  ▪ More Status Available Event Pending                                                                                   | –       |
| First unACK Time                    | Indicates the time in seconds an event notification has remained unacknowledged.                                                                                                                               | –       |
The **Standard Event Mask** tab contains the standardized HART events. Activate the appropriate checkbox to activate event notification for the associated condition.

**Checkboxes deactivated**
5.8 Power Supply

Battery life can be extended by tuning the adapter to energy requirements of the connected device. In addition, knowledge of the power requirements ensures a more reliable prediction of battery life. For some HART devices, the power parameters are displayed in the Field Device Table. For other HART devices and for 4...20 mA devices, they must be taken from the operating manual and entered manually. The tuning is done in the Power Supply leaf of the Adapter DTM.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>...</td>
<td>The <strong>Device-Specific Event Mask</strong> tab contains device-specific events. Activate the appropriate checkbox to activate event notification for the associated condition (see manufacturer’s operating manual).</td>
<td>Checkboxes deactivated</td>
</tr>
</tbody>
</table>

Figure 5.14 Power Supply parameters
Figure 5.15 Parameters influencing the power requirement of the WirelessHART adapter
### Power Supply Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power mode</strong></td>
<td>Sets the power mode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ &quot;Off&quot;: Power to any connected device is switched off. There is no communication between adapter and any connected device. Set this mode if the adapter is to be used as a router.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ &quot;Automatic&quot;: The connected device is powered-up when an external master starts communicating with the adapter. The device is powered after the last command for a period determined by &quot;Power On Time After External Trigger&quot;.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>■ &quot;Configuration&quot;: The connected device is powered-up when the button on the adapter is pressed or an external master communicates with it. The device is powered after the last command for a period determined by &quot;Configuration Time&quot;. When this period has elapsed, the power mode reverts to &quot;Automatic&quot;</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Field Device Table</strong></th>
<th>Displays the parameters read from the HART device by the scan:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>■ Manufacturer ID: Manufacturer of connected device</td>
</tr>
<tr>
<td></td>
<td>■ Expanded Device Type Code: Device identifier as per HART</td>
</tr>
<tr>
<td></td>
<td>■ Device ID: Manufacturer’s device identifier</td>
</tr>
<tr>
<td></td>
<td>■ Universal Command Revision Level: HART revision supported</td>
</tr>
<tr>
<td></td>
<td>■ Long Tag: Long tag of device (Message for HART revision &lt; 6.0)</td>
</tr>
<tr>
<td></td>
<td>■ * Start-Up Voltage: Voltage required to start the connected device</td>
</tr>
<tr>
<td></td>
<td>■ * Start-Up Time: Time required for the device to wake-up</td>
</tr>
<tr>
<td></td>
<td>■ * Start-Up Current: Current consumed on starting the device</td>
</tr>
<tr>
<td></td>
<td>■ * Lead Time: Time that elapses between start-up and the point when the HART communication is synchronized</td>
</tr>
<tr>
<td></td>
<td>■ * Parameters taken from DTM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Apply field device power values</strong></th>
<th>Press this button to apply the field device power values.</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Start-Up Voltage</strong></td>
<td>Voltage required by the connected device on start up.</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Valid range 8 ... 23 V in steps of 0.1 V.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Filled automatically if the Field Device table is active.</td>
<td></td>
</tr>
<tr>
<td><strong>Start-Up Time</strong></td>
<td>Time in seconds required for the device to start up.</td>
<td>5</td>
</tr>
<tr>
<td></td>
<td>Filled automatically if the Field Device table is active.</td>
<td></td>
</tr>
<tr>
<td><strong>Start-Up Current</strong></td>
<td>Current in mA drawn by the connected device during start-up.</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>Filled automatically if the Field Device table is active.</td>
<td></td>
</tr>
<tr>
<td><strong>Operating Voltage</strong></td>
<td>Voltage connected device requires in normal operation.</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>Filled automatically if the Field Device table is active.</td>
<td></td>
</tr>
<tr>
<td><strong>Lead Time</strong></td>
<td>Time that elapses between start-up and the point at which the device can deliver valid values. Filled automatically if the Field Device table is active.</td>
<td>10</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Default</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Power-On Time after External Trigger</strong></td>
<td>Time that the connected device remains powered after the last HART command. Applies to power mode &quot;Automatic&quot; only.</td>
<td>10</td>
</tr>
<tr>
<td><strong>Configuration Time</strong></td>
<td>Time that the connected device remains powered after the last HART command. Applies to power mode &quot;Configuration&quot; only.</td>
<td>300</td>
</tr>
<tr>
<td><strong>Battery Changed</strong></td>
<td>Press this button after a battery change to update the &quot;Last battery Change&quot; display and reset the battery consumption calculation.</td>
<td>–</td>
</tr>
<tr>
<td><strong>Last Battery Change</strong></td>
<td>Displays the date of the last battery change in DD:MM:YY.</td>
<td>–</td>
</tr>
<tr>
<td><strong>Temperature Min.</strong></td>
<td>Minimum temperature of the adapter since last temperature reset.</td>
<td>–</td>
</tr>
<tr>
<td><strong>Temperature Max.</strong></td>
<td>Maximum temperature of the adapter since last temperature reset.</td>
<td>–</td>
</tr>
<tr>
<td><strong>Reset Max./Min.</strong></td>
<td>Press this button to reset the Min/Max temperature monitor.</td>
<td>–</td>
</tr>
</tbody>
</table>
6 Operation

6.1 Controls and Indicators

The operating and display elements of the WirelessHART Adapter are located inside of the housing. → see Figure 2.2 on page 12
They are used during the commissioning of the device and for local diagnosis.

![Controls and indicators](image)

6.1.1 LEDs

When the pushbutton is pressed shortly (0.2 s ... 5 s), the three LEDs indicate the status of the adapter. See chapter 6.1.2

**Note!**
To save battery power all LEDs are off during normal operation, even if the device is communicating or joining the network. The LEDs only light up after start up or while pressing the buttons.

<table>
<thead>
<tr>
<th>Number of LEDs</th>
<th>3 (green, yellow, red)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indications of green LED (battery status)</td>
<td></td>
</tr>
<tr>
<td>LED on</td>
<td>Normal: at least one month of battery life is left.</td>
</tr>
<tr>
<td>LED flashes at 1 Hz</td>
<td>Warning: less than one month of battery life is left.</td>
</tr>
</tbody>
</table>
### 6.1.2 Buttons

Depending on the duration that the button is pressed and on whether the battery is already connected, the button calls different functions.

<table>
<thead>
<tr>
<th>Duration</th>
<th>Function</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 0.2 s</td>
<td>No function</td>
<td></td>
</tr>
<tr>
<td>0.2 s ... 5 s</td>
<td>Status test</td>
<td>- Press button for more than 0.2 seconds and less than 5 seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Release button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The LEDs display the current device status. See chapter 6.1.1</td>
</tr>
</tbody>
</table>
### Measured Value

The **Measured Value** function displays the current value and status of the variables selected in the **Device Variable Mapping** dialog.

The following information is displayed:

- Primary Variable
- Secondary Variable
- Tertiary Variable
- Quaternary Variable
- Loop-Current

<table>
<thead>
<tr>
<th>Duration</th>
<th>Function</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 s ... 10 s</td>
<td>Join wireless network</td>
<td>- Keep button pressed for 5 seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- After 5 seconds the yellow LED starts flashing at 3 Hz.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Release button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The yellow LED extinguishes.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The adapter starts joining.</td>
</tr>
<tr>
<td>10 s ... 15 s</td>
<td>Start configuration  mode</td>
<td>- Keep button pressed for 10 seconds. After 5 seconds the yellow LED starts flashing at 3 Hz.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- After 10 seconds the red LED starts flashing at 3 Hz.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The adapter enters configuration mode.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Release button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Configuration mode is retained until there was no HART communication for 300 seconds (configurable) or until pushbutton is pressed again for 10 seconds ... 15 seconds.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The red LED extinguishes.</td>
</tr>
<tr>
<td>&gt; 15 s</td>
<td>No function</td>
<td></td>
</tr>
</tbody>
</table>

**Inserting the battery while the button is already pressed**

The following functions are available when connecting the battery while the button is already pressed. The duration starts from the moment the battery is connected (red LED lights).

<table>
<thead>
<tr>
<th>Duration</th>
<th>Function</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; 10 s</td>
<td>No function</td>
<td>- The red LED lights until the pushbutton is released.</td>
</tr>
<tr>
<td>10 s ... 15 s</td>
<td>Configuration reset to default settings</td>
<td>- Keep button pressed for 10 seconds. The red LED lights during this time.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- After 10 seconds the red LED starts flashing at 2.5 Hz.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Release button to start the reset.</td>
</tr>
<tr>
<td>20 s ... 25 s</td>
<td>Firmware and configuration reset to default settings</td>
<td>- Keep button pressed for 20 seconds. During this time the red LED lights for 10 seconds. Then the red LED starts flashing at 2.5 Hz.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- After this, the red LED lights again.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- After 20 seconds the red LED starts flashing at 1.25 Hz.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Release button to start the reset.</td>
</tr>
<tr>
<td>&gt; 25 s</td>
<td>No function</td>
<td>- The red LED remains lit until the pushbutton is released</td>
</tr>
</tbody>
</table>

6.2
Accessing the Measured Value Window

1. In the PACTware™ project, right-click on the device.  
   - A context menu opens.
2. Select **Measured Value**.
   - The **Measured Value** window appears.

![Figure 6.2 Measured value](image1)

6.3 Simulation

Adapter parameters can be simulated for test and commissioning purposes. When the simulation is activated, the required parameter can be selected from a drop-down list. After a value has been assigned, the simulation is started by pressing **Execute Simulation**.

![Figure 6.3 Simulation](image2)
6.4 Diagnostics

The Diagnostics function provides detailed information about the device, wireless/wired communication and health status.

Note!

Available Only Online (DTM)

If using the configuration via DTM and PACTware™ the Diagnostics function is available only online. See chapter 5.2

Accessing the Diagnostics Window

1. Right-click the device in the PACTware™ project tree.
2. Select Diagnostics.
6.4.1 Identification

**Identification** provides information about the hardware and software of the device.

![Diagnosis - Identification](image)

**Note!**

If using the DTM and PACTware to configure the WirelessHART gateway, the following data is available only during online parameterization.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Long Tag</td>
<td>Identifies the device in a WirelessHART network.</td>
</tr>
<tr>
<td>Device Tag</td>
<td>Identifies the field device within the process plant</td>
</tr>
<tr>
<td>Descriptor</td>
<td>Further description of the device.</td>
</tr>
<tr>
<td>Date Code</td>
<td>Date, dd.mm.yy, indicating the date of the last parameter change</td>
</tr>
<tr>
<td>Message</td>
<td>User defined message.</td>
</tr>
<tr>
<td>Real time clock time</td>
<td>Shows the time currently set in the device.</td>
</tr>
<tr>
<td>Real time clock date</td>
<td>Shows the date currently set in the device.</td>
</tr>
<tr>
<td>Device Revision</td>
<td>Revision of the device.</td>
</tr>
<tr>
<td>Software Revision</td>
<td>Software revision of the device.</td>
</tr>
<tr>
<td>Hardware Revision</td>
<td>Hardware revision of the device.</td>
</tr>
<tr>
<td>Universal command revision</td>
<td>Revision of the HART protocol supported by the adapter.</td>
</tr>
</tbody>
</table>
6.4.2 Wireless Communication

Wireless Communication provides information about the operation of the device within the WirelessHART network.

![Diagnosis > Wireless Communication](image)

**Note!**

If using the DTM and PACTware to configure the WirelessHART gateway, the following data is available only during online parameterization.

**Diagnosis - Wireless Communication**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Identification</strong></td>
<td>Network ID of the wireless network.</td>
</tr>
<tr>
<td><strong>MAC</strong></td>
<td>MAC address of adapter</td>
</tr>
<tr>
<td><strong>Nickname</strong></td>
<td>Short destination address of the device.</td>
</tr>
<tr>
<td><strong>Total Number of Neighbors</strong></td>
<td>Number of WirelessHART devices to which a connection has been established.</td>
</tr>
<tr>
<td><strong>Wireless Health Status</strong></td>
<td>Key performance indicators of network communication:</td>
</tr>
<tr>
<td></td>
<td>- Index: Identifier of neighbouring device</td>
</tr>
<tr>
<td></td>
<td>- Nickname: Short destination address of neighbouring device</td>
</tr>
<tr>
<td></td>
<td>- Mean RSL: Mean signal strength of neighbour since adapter joined the network</td>
</tr>
<tr>
<td></td>
<td>- Packets Transmitted: Number of packets sent by adapter since joining the network</td>
</tr>
<tr>
<td></td>
<td>- Failed Transmits: Number of packets sent by adapter since joining the network and that failed to reach their destination (after retries)</td>
</tr>
<tr>
<td></td>
<td>- Packets Received: Number of packets received by adapter since joining the network</td>
</tr>
</tbody>
</table>
6.4.3 Wired Communication

Wired Communication provides information about the HART device(s) connected to the adapter.

![Figure 6.6 Diagnosis > Wired Communication](image)

### Diagnosis - Wired Communication

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Devices</td>
<td>Number of HART devices connected to the adapter.</td>
</tr>
<tr>
<td>Wired Communication Status</td>
<td>Key performance indicators of network communication:</td>
</tr>
<tr>
<td></td>
<td>- Index: Identifier of HART device</td>
</tr>
<tr>
<td></td>
<td>- Long Tag: Long tag of connected device</td>
</tr>
<tr>
<td></td>
<td>- STX Count: Number of transactions started by the adapter</td>
</tr>
<tr>
<td></td>
<td>- ACK Count: Number of HART device acknowledgements to adapter</td>
</tr>
<tr>
<td></td>
<td>- BACK Count: Number of HART device burst messages</td>
</tr>
</tbody>
</table>

6.4.4 Health Status

The Health Status menu contains diagnostic information. The information is displayed in three different ways according to:

- NAMUR NE107 guidelines,
- ASM guidelines,
- HART specification.

Open the corresponding sub-menu to view the respective information.
NAMUR

The following status messages according to the NAMUR NE107 guidelines can be displayed:

- Good
- Failure (F)
- Maintenance (M)
- Out of specification (S)
- Function check (C)

ASM

The following status messages according to the ASM guidelines can be displayed:

- Good, device operating as normal
- Faults in the sensor or actuator element
- Faults in the electronics
- Installation faults, fault during start-up
- Faults due to process influence, faults due to non-compliance with specified operating conditions.

**HART**

![Image of HART diagnosis interface]

**Figure 6.9** Diagnosis > Health Status > HART

**Diagnosis - Health Status - HART**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration Change Counter</td>
<td>Counter which increments by one on every change in adapter configuration.</td>
</tr>
<tr>
<td>Configuration Changed Flag</td>
<td>Indicates a change in configuration since the last call up.</td>
</tr>
<tr>
<td>Reboot Counter</td>
<td>Counter which increments by one on every reboot of the adapter.</td>
</tr>
<tr>
<td>Device Specific Status 0</td>
<td>Indicates network status.</td>
</tr>
<tr>
<td>Device Specific Status 1</td>
<td>Indicates wired communication status.</td>
</tr>
<tr>
<td>Device Specific Status 2</td>
<td>Indicates internal wireless communication module status.</td>
</tr>
<tr>
<td>Device Specific Status 3</td>
<td>Indicates status of current signal of the connected device.</td>
</tr>
<tr>
<td>Device Specific Status 4</td>
<td>Indicates a device malfunction.</td>
</tr>
<tr>
<td>Extended Device Status</td>
<td>Indicates the general status of the device.</td>
</tr>
<tr>
<td>Standardized Status 0</td>
<td>Indicates the status of the adapter.</td>
</tr>
<tr>
<td>Analog Channel Saturated</td>
<td>Indicates that current signal of the connected device is overrange.</td>
</tr>
<tr>
<td>Standardized Status 2</td>
<td>Indicates the standardized status of the wired (HART) connection.</td>
</tr>
<tr>
<td>Standardized Status 3</td>
<td>Indicates the standardized status of the network.</td>
</tr>
<tr>
<td>Real Time Clock</td>
<td>Current time.</td>
</tr>
</tbody>
</table>
6.4.5 Power Supply

The Diagnosis > Power Supply > Battery menu contains information on the battery unit of the device.

![Diagnosis - Battery](image)

**Figure 6.10 Diagnosis > Battery**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimated lifetime</td>
<td>Number of days battery power will last under the current load conditions.</td>
</tr>
<tr>
<td>Battery Voltage</td>
<td>Current voltage of the battery</td>
</tr>
<tr>
<td>Consumed Energy</td>
<td>Current consumed energy</td>
</tr>
<tr>
<td>Normalized Consumed Energy</td>
<td>Consumed energy with respect to normalized conditions</td>
</tr>
<tr>
<td>Temperature</td>
<td>Current temperature of device.</td>
</tr>
<tr>
<td>Temperature Min</td>
<td>Minimum temperature of the adapter since last temperature reset</td>
</tr>
<tr>
<td>Temperature Max</td>
<td>Maximum temperature of the adapter since last temperature reset</td>
</tr>
</tbody>
</table>

6.5 Additional Functions

Accessing the Additional Functions Windows

1. Right-click the device in the PACTware™ project tree.
2. Select Additional functions and choose the desired function.
6.5.1 Lock / Unlock

You can protect the device against unauthorized or undeliberate parameter changes (write protection).

![Figure 6.11 Additional functions > Lock / Unlock](image)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock Code</td>
<td>- Unlocked: Adapter is unlocked, all parameters can be changed</td>
</tr>
<tr>
<td></td>
<td>- Lock Temporary: Adapter is locked. A device reset or power loss will unlock it</td>
</tr>
<tr>
<td></td>
<td>- Lock Permanent: Adapter is locked. It can be unlocked by a master only</td>
</tr>
<tr>
<td></td>
<td>- Lock All: Adapter is locked. It can be unlocked only by the master that locked it</td>
</tr>
<tr>
<td>Lock Status</td>
<td>- Device Locked</td>
</tr>
<tr>
<td></td>
<td>- Lock is Permanent</td>
</tr>
<tr>
<td></td>
<td>- Locked by Primary Master (Reset if Secondary master)</td>
</tr>
<tr>
<td></td>
<td>- Configuration Cannot be Changed</td>
</tr>
<tr>
<td></td>
<td>- Locked by Gateway</td>
</tr>
<tr>
<td>Wireless Module Firmware Update Lock</td>
<td>- Unlocked: Adapter firmware can be downloaded</td>
</tr>
<tr>
<td></td>
<td>- Locked: Adapter firmware cannot be downloaded</td>
</tr>
</tbody>
</table>

6.5.2 Update Firmware

**Update firmware** is used to download new adapter firmware locally or from an FTP server to the adapter. The parameter **Wireless Module Firmware Update Lock** in **Lock/Unlock** must be set to "Unlock" before the firmware can be downloaded.

**Caution!**

Important information concerning firmware update

Please heed the following information when updating the firmware:

- Before updating the firmware, please deactivate all burst modes using the **Burst Mode Control Code** parameter. See chapter 5.7.2
- Do not update multiple WirelessHART adapters via the wireless network at the same time. If you have several adapters, update one at a time.
6.5.3 Device DTM Info

Device DTM Info gives standardized information about the adapter to which the DTM is connected.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Tag</td>
<td>Normally identifies the measuring point in the plant</td>
</tr>
<tr>
<td>Firmware Version</td>
<td>Current firmware version of the adapter</td>
</tr>
</tbody>
</table>

6.5.4 Self Test

After pressing the Perform Self-Test button in the Additional Functions > Self Test menu the device carries out a self test.

The results of the self test can be seen in the Diagnostics menu. See chapter 6.4
6.5.5 About

Additional Functions > About displays information about the device, its manufacturer, and its firmware version.
7 Maintenance and Repair

7.1 Exchanging the Battery

Only batteries of type W-BAT-B2-Li can be changed in an area known to be hazardous. You can order these battery units from Pepperl+Fuchs under the part no. 220390.

**Danger!**

**Batteries in hazardous areas**

Batteries from Pepperl+Fuchs for this device may be brought into hazardous areas. However, always check if the battery is intact before transporting it into hazardous areas. Always transport batteries enclosed inside their original packages or already installed inside the device.

**Danger!**

**Loss of intrinsic safety**

The use of batteries other than specified voids the qualification for use in hazardous areas. Only use batteries of type W-BAT-B2-Li from Pepperl+Fuchs.

**Danger!**

**Possible damage because of wrong battery**

The use of batteries other than specified may cause damage to the device. Only use batteries of type W-BAT-B2-Li from Pepperl+Fuchs.

**Warning!**

**Caustic battery acid**

Leaking battery acid can cause personal injury and damage to the device.

- Never use batteries that are leaking.
- Never use batteries with external damage such dents or deep scratches, even if no battery acid is leaking.

**Danger!**

**Electrostatic discharge hazard**

The device contains non-conductive plastic parts. Care must be taken when operating the installed device because of possible electrostatic charges. Electrostatic charged surfaces may cause an ignition spark.

Electrostatic charges must be avoided. For example, do not rub the device and never clean plastic surfaces with a dry cloth. Always use a damp cloth instead.

**Note!**

You may open the housing and connect/disconnect the battery in Zone 1.

**Note!**

- When operating at ambient conditions different from the conditions specified, battery capacity can be reduced up to 50%.
- The device has internal battery diagnostics that can send a warning when battery conditions are outside the acceptable operating range.
Changing the Battery

1. Open the adapter housing by unscrewing the four Phillips screws.
2. Pull the battery connecting cable plug from its socket.
3. Press the two clips which secure the battery simultaneously to the middle and remove the old battery unit.
4. Press the new battery unit into position.
   → The pack is properly secured after the two clips have made an audible click.
5. Insert the battery connecting cable plug into the socket in the printed circuit board.
6. Close the housing cover and screw it tight.
7. Reset the measurement of the consumed battery charge by pressing the Battery Changed button in the device DTM. See chapter 5.8
   → The measurement is reset.

7.2 Disposal of Batteries

The battery / the battery unit is non-rechargeable. The batteries are non-hazardous when used according to the recommendations of the manufacturer. However, they do contain hazardous substances and therefore must be disposed of in compliance with the applicable laws and guidelines of the corresponding country.
8 Troubleshooting

8.1 Faults Indicated by LEDs

**Note!**
To save battery power all LEDs are off during normal operation, even if the device is communicating or joining the network. The LEDs only light up after start up or while pressing the buttons.

For more information on the LED indications, see chapter 6.1.1.

**Green LED (battery status)**

<table>
<thead>
<tr>
<th>State</th>
<th>Possible Cause(s)</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED flashes at 1 Hz</td>
<td>Warning: less than one month of battery life is left.</td>
<td>Change battery as soon as possible. See chapter 7.1</td>
</tr>
<tr>
<td>LED flashes at 3 Hz</td>
<td>Alarm: the battery is critically low, loop power cannot be supplied.</td>
<td>Change battery immediately. See chapter 7.1</td>
</tr>
<tr>
<td>LED off</td>
<td>Off: the battery is flat or disconnected.</td>
<td>Change/connect battery. See chapter 7.1</td>
</tr>
</tbody>
</table>

**Yellow LED (communication status)**

<table>
<thead>
<tr>
<th>State</th>
<th>Possible Cause(s)</th>
<th>Action(s)</th>
</tr>
</thead>
</table>
| LED flashes at 1 Hz       | Joined, no alternative path: the device was able to join the network. However, it can communicate with a single wireless node only. There is no alternative communication path to the gateway. | ■ Add a WirelessHART device that is within the antenna range of the adapter.  
■ Change the position of the adapter. |
| LED flashes at 3 Hz       | Joining: the device is attempting to join the network. | none                                            |
| LED off                   | Not joined: joining the network has failed. The device is no longer attempting to join.  
■ There are no communication paths available.  
■ No WirelessHART network has been set up so far.  
■ The Network ID and/or Join Key is not correct. | ■ Add a WirelessHART device that is within the antenna range of the adapter and try joining the network again.  
Change the position of the adapter and try joining the network again.  
■ Install a WirelessHART gateway first. Set up a WirelessHART network.  
■ Check Network ID and Join Key. |

**Red LED (device status)**

<table>
<thead>
<tr>
<th>State</th>
<th>Possible Cause(s)</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED on</td>
<td>Internal Fault: an internal fault condition has been identified</td>
<td>Send the device back to the manufacturer.</td>
</tr>
</tbody>
</table>
8.2 Wireless Communication Faults

<table>
<thead>
<tr>
<th>State</th>
<th>Possible Cause(s)</th>
<th>Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>LED flashes at 1 Hz</td>
<td>External Fault: operative fault that can possibly be remedied by the user (e.g. adapter temperature outside specified limits, measured value outside configured range).</td>
<td>Check the Diagnosis function of the DTM to find out what kind of error has occurred. See chapter 6.4</td>
</tr>
<tr>
<td>LED flashes at 3 Hz</td>
<td>Short-circuit: there is a short-circuit between terminals 1 and 2.</td>
<td>Check wiring.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Fault</th>
<th>Possible Cause(s)</th>
<th>Corrective Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>PACTware™ cannot find the device when communicating via WirelessHART Gateway.</td>
<td>The device has not yet joined the network.</td>
<td>The joining process may take a while. Check the join status in the gateway's Instrument List. Alternatively, check the wireless communication parameters (join status) of the device via a HART modem connected to the device. If the device does not join, check the next fault.</td>
</tr>
<tr>
<td>The device carries the wrong Network ID and/or Join Key.</td>
<td>Check the wireless communication parameters of the device via a HART modem connected to the device. The device and the gateway must have the same Network ID and Join Key.</td>
<td></td>
</tr>
<tr>
<td>The device does not join the network.</td>
<td>No battery or low battery</td>
<td>Check that a fresh battery of the correct type is inserted.</td>
</tr>
<tr>
<td>No neighboring WirelessHART devices are within the device's antenna range.</td>
<td>Check the number of neighbors in the device DTM (wireless communication parameters). There should be at least 2 neighbors.</td>
<td>■ If there are no reachable neighbors, check the device's mounting position: Are there any obstacles? If yes, change the mounting position. ■ If there are no reachable neighbors and you can not change the device's mounting position: Try moving an other WirelessHART device in the network, or adding a new one.</td>
</tr>
<tr>
<td>Device not mounted correctly</td>
<td>Check that the device has been mounted correctly. See chapter 3.1</td>
<td></td>
</tr>
<tr>
<td>Device not trying to join</td>
<td>Check whether the device is trying to join the network (LEDs): if not, start a new connection attempt by pressing the correct button. See chapter 6</td>
<td></td>
</tr>
<tr>
<td>Device disappears sporadically from the network</td>
<td>There are not enough neighboring WirelessHART devices within the antenna range of the device.</td>
<td>Check the number of neighbors in the device DTM (wireless communication parameters). There should be at least 2 neighbors.</td>
</tr>
</tbody>
</table>
### 8.3 Wired Communication Faults

<table>
<thead>
<tr>
<th>Fault</th>
<th>Possible Cause(s)</th>
<th>Corrective Action(s)</th>
</tr>
</thead>
</table>
| PACTware\textsuperscript{TM} cannot find the adapter when communicating via a HART modem. | HART communication DTM not connected to correct COM port | Select the correct COM port from the drop-down menu.  
| | | ■ RS-232C = COM1 or COM2  
| | | ■ USB = COMx as displayed  
| | | Check to which COM port your HART modem is connected. Then set the correct COM port in the HART communication DTM. See chapter 4.5.2 | |
| | HART modem plugged into wrong USB port (some computers assign fixed COM ports to USB ports). Maybe you are using a different USB port than during setup. | | Plug the HART modem into the correct USB port.  
| | | Alternatively, adjust the COM port setting in the HART communication DTM. See chapter 4.5.2 | |
| | Adapter address not found by the HART communication DTM | | Configure the correct address range. See chapter 4.5.2  
| | | Default adapter address = 15 | |
| | For USB/HART modems, voltage level at Terminals 7 and 8 to high for reliable communication | | Switch in the communication resistor or connect a 250 $\Omega$ resistor across terminals 5/7 and 6/8. | |
| A field device powered by the adapter will not start up | Battery not connected or exhausted | Check the connection, if necessary replace the battery.  
| | | A simple check is to shake the adapter or battery unit. If you hear liquid, the battery still has life. | |
| | Power supply parameters are incorrect | | Find the correct parameters in the device manual and enter them into the DTM. See chapter 5.8 | |
| | Connected field device has a very low impedance - the adapter interprets this as a short-circuit and switches off the power | | Connect a resistor in series with the device, for example, a 250 $\Omega$ resistor. | |
| | The parameters of a field device powered by the adapter cannot be read by the adapter DTM. Wired Communication Dialog: see chapter 5.5 | Device does not support HART protocol | Parameters can be read from a HART device only. | |
| | | Device address not found by the Adapter DTM | Check the highest scan address. See chapter 5.5 | |
| | | Device not powered | See previous fault. | |
| | | Device powered, but shuts down before it communicates | Increase power supply parameter "Lead Time" in steps of 10 s until the fault is eliminated. See chapter 5.8 | |
### Troubleshooting

<table>
<thead>
<tr>
<th>Fault</th>
<th>Possible Cause(s)</th>
<th>Corrective Action(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>The parameters of an independently operating 4-wire field device cannot be read by the adapter DTM. Wired Communication Dialog: see chapter 5.5</td>
<td>Device does not support HART protocol</td>
<td>Parameters can be read from a HART device only.</td>
</tr>
<tr>
<td></td>
<td>Device address not found by the Adapter DTM</td>
<td>Check the highest scan address. See chapter 5.5</td>
</tr>
<tr>
<td></td>
<td>Device not powered</td>
<td>Check the power supply of the device.</td>
</tr>
<tr>
<td></td>
<td>Device not wired up correctly</td>
<td>Check the wiring.</td>
</tr>
<tr>
<td>The parameters of a field device in a control loop cannot be read by the adapter DTM. Wired Communication Dialog: see chapter 5.5</td>
<td>Device does not support HART protocol</td>
<td>Parameters can be read from a HART device only.</td>
</tr>
<tr>
<td></td>
<td>Device address not found by the Adapter DTM</td>
<td>Check the highest scan address. See chapter 5.5</td>
</tr>
<tr>
<td></td>
<td>Device not powered</td>
<td>Check loop power.</td>
</tr>
<tr>
<td></td>
<td>Device not wired up correctly</td>
<td>Check the wiring of the device.</td>
</tr>
<tr>
<td></td>
<td>PLC or Remote I/O acting as primary master forces adapter to operate as slave</td>
<td>Configure adapter as secondary master. See chapter 5.5</td>
</tr>
<tr>
<td>PACTware™ cannot find a field device connected to Terminals 1 + 2 or 2 + 3 of the adapter when communicating through a HART modem connected to Terminals 5/7 and 6/8</td>
<td>For control loops with communication resistor: Device address not found by the HART communication DTM</td>
<td>Configure the correct address range. See chapter 4.5.2</td>
</tr>
<tr>
<td></td>
<td>For control loops without communication resistor, for 2-wire devices powered by adapter and for 4 wire devices: No communication path to device (design feature)</td>
<td>Depending upon circuit, connect modem across terminals 1 and 2 or 2 and 3. Configure the correct address range. See chapter 4.5.2</td>
</tr>
<tr>
<td></td>
<td>For all connections: Device not powered</td>
<td>Check the power supply of the device.</td>
</tr>
<tr>
<td>Adapter does not restart after disconnecting and connecting the battery</td>
<td>Battery reconnected before adapter power fully discharged</td>
<td>1. Disconnect the battery again. 2. Press button for 3 seconds. 3. Wait one minute. 4. Reconnect the battery.</td>
</tr>
<tr>
<td>PACTware™ cannot find a connected HART device when communicating via WirelessHART Gateway.</td>
<td>Device does not support HART protocol</td>
<td>Parameters can be read from a HART device only.</td>
</tr>
<tr>
<td></td>
<td>Device address not found by the Adapter DTM</td>
<td>Check the highest scan address. See chapter 5.5</td>
</tr>
<tr>
<td></td>
<td>Device not powered</td>
<td>See second fault.</td>
</tr>
<tr>
<td></td>
<td>Device powered, but shuts down before it communicates</td>
<td>Increase power supply parameter “Lead Time” in steps of 10 s until the fault is eliminated. See chapter 5.8</td>
</tr>
</tbody>
</table>
9 Appendix

9.1 Telecommunication Compliance

- ETSI (R&TTE)
- FCC Part 15.247 for wireless applications in the area of 2.4 GHz
- EN 300 328

The usage of 2400 MHz equipment is bound to local restrictions. Ensure that local restrictions allow usage of this device before commissioning.

<table>
<thead>
<tr>
<th>Country</th>
<th>Guideline</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bulgaria</td>
<td>General authorization required for outdoor use and public service.</td>
</tr>
<tr>
<td>Italy</td>
<td>If used outside of own premises, general authorization is required.</td>
</tr>
<tr>
<td>Japan</td>
<td>The device is granted pursuant to the Japanese Radio Law and the Japanese Telecommunications Business Law. The device must not be modified (otherwise the granted designation number will become invalid).</td>
</tr>
<tr>
<td>Latvia</td>
<td>The outdoor usage of the 2.4 GHz band requires an authorization from the Electronic Communications Office.</td>
</tr>
<tr>
<td>Norway</td>
<td>May be restricted in the geographical area within a radius of 20 km from the center of Ny-Alesund.</td>
</tr>
<tr>
<td>Romania</td>
<td>Use on a secondary basis. Individual license required.</td>
</tr>
</tbody>
</table>
9.2 Dimensions